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2. Before the Migration 

Click&DECiDE cannot be installed on the same machine where DataSet Vision or DataSet Report 2009 is 
already installed unless you uninstall first these previous products. 

If you do not uninstall these previous products, the Click&DECiDE Setup will automatically detect these 
program and will ask you to uninstall them before installing Click&DECiDE. 

This manual will explain some recommendations to be done before uninstalling DataSet Vision or DataSet 
Report 2009 if you wish to keep your previous configuration. 

Download the last release of Click & DECiDE here: 

http://license.clickndecide.com/downloads/cndent_request.aspx 

 

Note: the operations described in this article require a full access to the computer. Be sure to be 
logged as an Administrator. 

http://license.clickndecide.com/downloads/cndent_request.aspx
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3. Section 1: Backup your current configuration 

3.1. Backup your License Certificates 

For DataSet Vision save your DataSet Vision license that could be in:  
C:\Program Files\DataSet\DataSet Vision\d7vision.cert (by default). 

Or in the following locations if you were also using the NetReport software’s: 
C:\Program Files\NetReport\Dataset\d7vision.cert (by default). 
C:\Program Files\NetReport\WebPortal\d7vision.cert (alternate) 

For DataSet Report 2009 save your DataSet Report license that could be in:  
C:\Program Files\DataSet\DataSet Report\ _license.cert (by default). 

This backup is only necessary if you wish to reinstall later DataSet Vision or DataSet Report 2009. 

For Click&DECiDE you will need to get a new license certificate (you can get a temporary license 
certificate if you download the software or ask your provider to get this certificate). Make sure to get this 
new license certificate before installing Click&DECiDE. 

3.2. Backup the DataSet Server Configuration 

For DataSet Report 2009: 

1. Start the DataSet Server Administrator: Start> All Programs> DataSet> Tools> Administrative 
Tools>Server Administrator. 

 

For DataSet Vision: 

1. Start the DataSet Server Administrator: Start> All Programs> DataSet> Tools> Administrative 
Tools>Server Administrator. 
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2. Go to File>Backup Security Database 
 

 

3. Save the Security Database configuration into a .bck file. 
 
This backup file contains: 
all information about the above Data Sources Tab (Data Source Configuration) 
all information about the above User Groups Tab (User Groups) 
all information about the above Users Tab (Users) 
all information about the above Menus Tab (Menus name and path) 
 
This backup file does not contain: 
your DataSet Vision project files (*.wfv) 
your EBIS project files (*.wfd) 
your ASCII List parameter files (*.lst) 
your Web Menu Builder files (*.wmu) 
your Scheduled Tasks 
your DataSet Model files (*.mod) 
your Visual Basic Scripts (*.vbs) 
Any pictures used in your reports or EBIS project files. 

4. Close DataSet Server Administrator. 

5. Save your own DataSet Vision projects (*.wfv files) created with the DataSet Vision software. 

6. Save your own EBIS projects (*.wfd files) created with the EBIS software. 

7. Save your own Web Menu Builder (*.wmu files) created with the Web Menu Builder software. 

8. Save your own DataSet Model (*.mod files) created with the DataSet Model software. 
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9. Save your own Visual Basic Scripts (*.vbs files) if needed. 

10. Save the external files, for example the pictures and the ASCII List parameter (*.lst files), used by your 

own DataSet Vision projects. 

11. Save the scheduled tasks configuration file d7tasks.xml located at: 
C:\Program Files\DataSet\DataSet Vision\d7tasks.xml (by default) or 
C:\Program Files\DataSet\DataSet Report\d7tasks.xml (by default). 

12. Save your own script (if applicable) which are located at:  
C:\Program Files\ DataSet\DataSet Vision\TaskScripts (by default) or 
C:\Program Files\DataSet\DataSet Report\TaskScripts (by default) 
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4. Section 2: Requirements for Click & DECiDE - BAI 

4.1. Turning on the Required IIS Features 

IIS is a Windows feature, to launch the Turn Windows Features On or Off module please follow the steps 
below: 

1. Select Start> Control Panel. 

2. Click Programs and Features. 

3. Click Turn Windows Features On or Off 

4. Select the following Internet Information Services features: 

5. Web Management Tools 
a. IIS Management Console 
b. IIS Management Scripts and Tools 
c. IIS Management Service 

6. World Wild Web Services 
a. Applications Development Features 

i. ASP.NET 
ii. ASP 

b. Security 
i. Basic Authentication 
ii. Windows Authentication 

7. Click OK 

4.2. Requirement about the Framework .NET 3.5 SP1 

Click&DECiDE needs the Framework .NET to work properly. Note that the Framework .NET 3.5 will be 
automatically installed by the Click&DECiDE Setup is missing. 

Important warning: note that Framework 3.5 must be installed after IIS. 

If you wish to install yourself the latest version of Framework 3.5 before installing Click&DECiDE. Follow 
the link and install the framework: 

http://www.microsoft.com/downloads/details.aspx?familyid=AB99342F-5D1A-413D-8319-
81DA479AB0D7&displaylang=en  

If the Framework 3.5 has been installed before IIS, the problem could be that IIS does not recognize the 
Framework 3.5. In that case the ASP.NET Tab does not appear in the Default Web Site Properties. 

To solve this problem, run the following command: aspnet_regiis –i  

From IIS Management Console, select the default web site, click on right button and display properties. 

The ASP.NET property page should appear as below: 

http://www.microsoft.com/downloads/details.aspx?familyid=AB99342F-5D1A-413D-8319-81DA479AB0D7&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=AB99342F-5D1A-413D-8319-81DA479AB0D7&displaylang=en
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 If the ASP.NET property page doesn’t appear, try to reboot. 

4.3. Download and extract the Click & DECiDE - BAI setup 

1. Download the latest Setup of Click&DECiDE BAI Enterprise Edition 10.01.02, CnD-BAI.10.01.02.exe, 
available at: 
http://license.clickndecide.com/downloads/cndent_request.aspx 

2. Run the CnD-BAI.10.01.02.exe setup. 

http://license.clickndecide.com/downloads/cndent_request.aspx
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Choose where you want to extract the files required for the installation. 
 

 

3. Click Next. 

4. Wait for the extraction to complete. The Click and DECiDE - BAI Installation Wizard will launch. 
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5. Section 3: The Click and DECiDE - BAI Installation 

5.1. System Requirements 

The Click&DECiDE setup program will check first if the required software is already installed on your 
computer and will propose to install them if necessary. The Click&DECiDE system requirements are as 
follows: 

Desktop Version (Express and Standard Editions) 

Microsoft Web Components 
SQL Server Native Client 

Web Server Version (Professional and Enterprise Editions) 

Microsoft Web Components 
SQL Server Native Client 
SQL Server 2005 Express or greater 
Microsoft .NET Framework 3.5 

Note: for the Professional or Enterprise Editions, you must install Microsoft IIS (Interne Information 

Services) before installing the Microsoft .NET Framework 3.5. 

5.2. Environment 

Desktop Version (Express and Standard Editions) 

Windows XP SP2 or greater 
Windows Vista SP1 or greater 
Windows 2003 SP2 or greater 
Windows 2008 SP1 
Windows 7 

Web Server Version (Professional and Enterprise Editions) 

Windows 2003 SP2 
Windows 2008 SP1 

5.3. Installation 

If you have downloaded the software, please perform the following steps: 

Double-click the downloaded file (for example CnD-BAI.WeBServer.10.1.2.exe)  

Extract the content by default to the following directory: 
C:\Program Files\Click and DECiDE\Setup files 

Note the Setup.exe file will automatically run to start the installation. 

5.4. Running the Setup.exe File 

Perform the following steps: 

a. If you have a CD-ROM: double-click the Setup.exe file unless your CD drive is defined with an 
automatic start.  
b. If you downloaded the software: double-click the downloaded file 
The following screen will appear if the previous software has not been uninstalled: 

Click “I want to continue” then click OK 
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For Click&DECiDE Professional or Entreprise Edition, if the Framework .NET 3.5 is not installed, you will 
get this message. Click OK. 

 

For Click&DECiDE Professional or Entreprise Edition, if SQL Server Express 2005 is not installed, you will 
get this message. Click Install to continue or Cancel to abort: 

 

If SQL Server Express 2005 is already installed and the Framework .NET 3.5 is also already installed, and 
if the detected previous product is not Click&DECiDE but DataSet Vision or DataSet Report, you will get 
this message. Click OK. 
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Click Finish 

 

Uninstall the previous software. 

Reboot the machine and run again the SETUP.EXE for Click&DECIDE. 
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Select I accept the terms in the license agreement to contine. 

Click Next>. 

 

 Click Next>, or click Change… to install the software to a different folder. 
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Click Next> to install all the Click&DECiDEproducts or select the Setup Type that best suits your needs. 

 

 

IMPORTANT NOTE 

The Management Console is not installed by default. If you wish to install this component, perform the 

following steps: 
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1. Click Custom Setup. 

2. Click Next>. 

3. Select the Click and DECiDE Event Manager branch. 

4. Select Management Console. 

5. Select This feature will be installed on local hard drive.  
 
Note: this module is reserved to the Administrator or Advanced Users. It can be used in relation with the 

Click and DECiDE Event Manager Engine, for Alert Management and Web Server Statistics. 

 

 

Note: if you do not wish to install all the native database engines proposed by Click&DECiDE, then select 
the Click and DECiDE Drivers branch to view all the proposed data sources. 
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The following drivers can be installed: 

Click and DECiDE Connect:  the data source allowing a client workstation with only Click and DECiDE 

Builder to: 

-Either: connect to a data source defined in the full Professional or Enterprise Edition installed on a 
Server,  

-or create a data source in a Professional or Enterprise Edition installed on a Server but pointing to 
another server where a Professional or Enterprise Edition has also been installed. 

Click and DECiDE Model:  the data source allowing access to a Model defined with the Click and 

DECiDE Model tools (only available in the Enterprise Edition). 

Click and DECiDE iSeries TCP/IP:  the data source allowing access to an IBM iSeries machine (AS/400) 
using the TCP/IP protocol. Note: a Host Program must be installed on the AS/400. 

Click and DECiDE Oracle: the data source allowing access to an Oracle database. Note: an Oracle 

client module must be installed first on the machine where Click and DECiDE is goint to be installed. 

Click and DECiDE SQL Server: the data source allowing  access to an SQL Server database, installed 

by default when you install Click&DECiDE for the first time. 

Click and DECiDE UDB: the data source allowing access to an IBM Universal Data Base (UDB/DB2). 
Note: an IBM UDB client module must be installed first on the machine where Click&DECiDE is going to 

be installed. 

Click Next> to continue the installation. The Service Logon screen appears 
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The built-in Local System account: by default, all Click and DECiDE services will run under The built-in 
Local System account. 

A domain user account:  specify a domain user account if you wish to run the services under another 

profile.  

Click Next>. The “Ready to Install the Program” message appears. 

Click Install to launch the installation or <Back to modify a previous option. 
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Note the following screen appears once all the programs have been installed. 

 

Click Finish. A message will appear asking you to restart your computer. 

Click Yes if you wish to reboot now. 

 

 

5.5. Running the Configuration Wizard 

Once your computer has restarted, the Click and DECiDE Configuration Wizard will be launched 
automatically. Perform the following steps. 

Click Change… to select your license certificate or click Get an online license if you do not have a 

license certificate file (license.d7cert): 
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Note the information concerning your license certificate will appear. In the example above, the license 
certificate displays information about your Edition, the version number, the number of CALs (Client 
Access Licenses) for the Click and DECiDE Builder, the number of CALs for the Web Portal and the 
number of Concurrent Users for the Web Portal. The certificate also displays information concerning 
whether you are under a Maintenance Agreement with the expiry date and displays the expiry date of the 
certificate if you do not have a permanent license certificate.  



 

18 
 

 

 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 

Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 

To contact your nearest Click&DECiDE partner, click here. 

Business Application Intelligence | KBA 

Click Next> to continue. The Web Portal and Mail Configuration screen appears. 

 

Specify the Web Portal Authentication Mode you want to use. 
Note: Windows Authentication is selected by default and Web Portal Authentication Mode is 

recommended by Click&DECiDE. 

Specify the Mail Server Name  

Click Test to check your Mail Server Name. Click Next>. The Database Configuration screen appears. 
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Note the SQL Server Instance Name is SQLExpress by default.  

Note: the last step consists of inserting the required tables and the demonstration samples in the Local 
SQL Server. This step is mandatory because certain tables are required by the Alerts and Statistics 
Management module. 

 

Select the Authentication Mode. For the SQL Server connection, choose between Windows 
Authentication and SQL Server Authentication.  

Click Finish to terminate the setup. 

Click Yes to continue. 

 

 

 

Click Finish to exit the configuration. The ReadMe file will be displayed. 
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6. Section 4: Restore your configuration 

6.1. Restoring the Web Portal Configuration 

1. Restore your own DataSet Vision projects (*.wfv files) created with the DataSet Vision or DataSet Report 
2009 software’s.  

2. Restore the external files (for example, the pictures and ASCII List files *.lst if needed) used by your own 
DataSet Vision projects. Warning: if you have used an environment variable such as 
%D7VISION_PATH% or %DATASET_DEMO% with DataSet Vision, pointing to the default installation 
directory C:\Program Files\DataSet\DataSet Vision, the same environment variable with Click&DECiDE 
will point to the default directory C:\Program Files\Click and DECiDE\BAI. Make sure the pictures files or 
ASCII List files are in a correct location regarding the new environment variable. In any other case you 
could be obliged to check and change if needed all your path name in all your projects files (*.wfv, *.wfd, 
*.wmu etc.) 

3. Restore your customized Web Menus in a location taking care about the environment variable used. 

4. Locate the Security Database backup file (.bck) on your hard drive. 

5. Double click on the file having the “bck” extension. Administration Manager will ask you if you want to 
restore the Security Database. 

 

6. Click Yes. 
 

7. Verify that your configuration is correct. You should see the same Data Sources Tab, the same User 
Groups Tab, the same Users Tab and Menu Tabs as before installing Click&DECiDE. 
Check for example the access to the Web Menu files to be sure they have been copied in the right 
location. 
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8. Click Update Security icon 
 

 

9. Click OK. 

 

10. Close Administration Manager. 

6.2. Restoring the Web Menu Buidler Files 

Once you have restored the Web Menu Builder files (*.wmu), make sure the menus will still access to the 
DataSet Vision project files (*.wfv): 

1. Run the Web Menu Builder application. 

2. Open any Web Menu file you have restored (*.wmu). 

3. Open any branch pointing to a DataSet Vision project file (*.wfv). 

4. Double click on any item to display the Properties 

5. Check if the location path is still valid in the General Tab: 
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Click OK and Save the Menu file in case of any change.  

6.3. Restoring the Scheduled Tasks 

If you have very few scheduled tasks to be converted to Click&DECiDE, you will save time by creating new 

tasks through the Click&DECiDE Web Portal. (Recommended). Please refer to the Web Portal documentation 

for more information. 

http://www.netreport.fr/downloads/WebDoc/BAI/ClicknDECiDE_BAI_Web_Portal_User_Guide.pdf 

If you have many scheduled tasks to be converted to Click&DECiDE, the procedure is given here below, but 

this process requires an advanced knowledge of the product. 

1. Stop the Click and DECiDE Task Manager Service. 

2. Restore your own d7tasks.xml file in the C:\Program Files\Click and DECiDE\BAI directory. 

3. Edit this file with any text editor. 

4. Check the path to all the Builder Project files (*.wfv) if the new location has changed. 
Example: <visionproject>%DATASET_DEMO%\DemoWeb\DataSet DemoWeb.wfv</visionproject> 

5. Check the Menu Names and Menu IDs (if they have changed, replace with the new one). 
Example: <menualias>DemoWeb</menualias> and <menuitemid>2316</menuitemid> 

6. Check the path in all output destination file, such as the following example: 
<outfilename>%DATASET_DEMO%\DemoWeb\Demo Multi Criteria.pdf</outfilename> 

7. Replace the encrypted password with visible password (they will be again encrypted when starting later 
the Click and DECiDE Task Manager Service). 
Example: <password>ENC 03D2692384D99A8A3DC791337B68A585</password> 

8. Check the path for the location program running the tasks (d7RunTask.exe). 
Replace: 

<program>C:\Program Files\DataSet\DataSet Vision\d7RunTask.exe</program> 

with 

<program> C:\Program Files\Click and DECiDE\BAI\d7RunTask.exe</program> 

9. As this row anywhere in the task: <sendalert>0</sendalert>. 
10. Save the d7tasks.xml file thus modified. 
11. Restart the Click and DECiDE Task Manager Service. All visible passwords will be encrypted again. 

http://www.netreport.fr/downloads/WebDoc/BAI/ClicknDECiDE_BAI_Web_Portal_User_Guide.pdf
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6.4. Restoring the Visual Basic Scripts 

If you have created your own Visual Basic Script under DataSet Vision version 5.x and make a backup of all 

these scripts (*.vbs file): 

1. Restore all the VBS files in the location of your choice. 

2. Edit all the VBS files with a text editor. 

3. Check all the paths that may have change between DataSet Vision and Click&DECiDE. 

4. Save all the modified VBS files. 

6.5. Restoring the DataSet Model Files 

If you have used the DataSet Model software: 

1. First check the Data Source Model restored in the Administration Manager and check if the path to the 
Model file is still correct (*.mod). Example: 

 

 
 

2. Validate and test the connection to the specified data source. 

3. If Model parameters have been used linked to User Groups or Users inside Administration Manager, 
check if the path to the Model files are still correct, example: 

 

 
 
In the above example, a link to a Model file appears as broken because the Model file does not exist anymore. 
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The three other links appear as being correct. 
 

6.6. Restoring the EBIS Application files 

The EBIS Application files is now called Click&DECiDE Dashboard and concerns the files having the 
extension *.wfd. If you have used this application: 
 

1. First restore the EBIS project files (*.wfd) in the location of your choice. 

2. Then open each EBIS project file with the Dashboard application. 

3. Check the path to the DataSet Vision project files (*.wfv) and to any picture file. 
 
Note: if you have develop your EBIS project files using a relative path or an environment variable, it should 
work without any modification if the location of the DataSet Vision project files (*.wfv) and the pictures files are 
still correct.  
 
A relative path was searching a DataSet Vision project file (*.wfv) or a picture file using the following syntax: 
.\MyVisionProjectFile.wfv or .\MyPicture.jpg 
If the Dashboard project file is still in the same directory as the DataSet Vision project file and the pictures 
used, it will work without any modification. 
If not you should check all path accessing to a DataSet Vision project file or a picture file. 
 
A path with an environment variable was searching a DataSet Vision project file (*.wfv) or a picture file using 
the following syntax: 
%D7VISION_PATH%\DemoWeb\MyVisionProjectFile.wfv or %D7VISION_PATH%\Samples\MyPicture.jpg 
 
%D7VISION_PATH% being the default directory installation: C:\Program Files\DataSet\DataSet Vision 
 
With Click&DECiDE the same environment variable will refer to C:\Program Files\Click and DECiDE\BAI. 
Make sure the access path is still valid with the Click&DECiDE product. 
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